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A. IN THE BOX

1. INTRODUCTION 
Thank you for purchasing the Delta Optical Smart PRO Microscope with a 5MP sensor and professional stand.  Your 

microscope is a precision optical instrument, made of the highest quality materials to ensure durability and long life. It is 

designed to give you a lifetime of pleasure with a minimal amount of maintenance.

Before attempting to use your microscope, please read 
through thet instructions and reference the diagrams 
below.  Familiarizing yourself with the many features of 
the DO Smart PRO 5MP Microscope will go a long way 
to making your experience an enjoyable one.

The DO Smart PRO 5MP Microscope provides low 
powers from 20x up to 200x and connects to your 
Macintosh or Windows PC via USB 2.0. (NOTE: 
Depending on the size of your monitor, you may be 
able to attain 800x magnifi cation) This microscope is 
a low magnifi cation power microscope, mainly suited 
for examining specimens like coins, stamps, rocks, 
electronics, insects, and other 3D objects.  Specimens 
on slides can be viewed, but this microscope is not ideal 
for this purpose. You can see some of our biological 
microscopes more suited to this type of viewing at:
www.deltaoptical.pl/blizej_zycia

The Delta Optical Smart PRO 5MP Microscope does 
not use an eyepiece like a traditional microscope. 
Instead, the camera sensor “sees” the specimen with 
10x magnifi cation, and the image is displayed on the 
computer screen.  This makes viewing fun, cuts down 
on eye and neck strain, and allows for easy sharing with 
others. You can hold the microscope in your hand while 
observing large surfaces away from a normal lab setting, 
or use the included professional stand for more precise, 
hands-free viewing. Recording still images and video 
is a snap. You can save, transfer, and share your image 
fi les quickly and easily with the included Delta Optical
Smart Analysis PRO software.

Take some time to read the simple care, maintenance 
tips in this manual to ensure that your Delta Optical
Smart PRO 5MP Microscope provides you with years 
of quality performance.

Microscope (1) Professional Stand (1) Quick Setup Guide (1)

CD (1) Calibration Ruler (1)                 

QUICK START GUIDE
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B. PARTS

NO.      FU NCTIO N

1. Lock Wheel

2. Height Adjustment Wheel

3. Focus Wheel

4. Height Adjustment Lock Nut

5. Microscope Holder lock Nut

6. Shaft Connection Lock Collar

7. Shutter Button

8. Illuminator Adjustment Wheel

9. USB Plug

10.  Stage Base

11.  Support Shaft
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5 MP, 4 MP, 3 MP, 2 MP, 1.3 MP

Windows: windows 7.0/8.0/10.0
Mac: OSX 10.12 or above
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C. SPECIFICATIONS

Manufacturer Delta Optical

Camera sensor size 5 MP (mega pixels)

Stand Professional stand with adjustable height

Lens 5 element IR cut , high quality GLASS /EFL(Equivalent Focal Length): 15.8 mm /FOV: 13.0”

Focuser range 10 mm to 150 mm

Illuminator Upper ring-  5 bright white adjustable LEDS (adjuster on cord)

Magnifi cation 20x to 300x 

Shutter trigger On cord – limits image shake

Still Image resolution 5 MP, 3 MP, 1.3 MP, VGA (12 MP with interpolation*)

Video resolution VGA, 30fps

Computer interface 2.0 USB

Software Delta Optical Smart Analysis PRO (with measuring and note taking features)

Operating systems supported Windows: Windows XP/Vista/7.0/8.0                                                                                         
Mac: OSX 10.6/10.8

Software languages English, German, French, Spanish, Russian, Italian, Portuguese, Danish, Polish, Japanese, 
Korean, Chinese, Ukrainian, Hungarian, Lithuanian

Minimum system requirements 512MB RAM/ 64M Video Memory/ Open USB port/ CD-ROM Drive

Dimensions Microscope: 110x35 mm (4.33”x1.38”)                                                                                       
Stand:  175x140x110 mm (6.90”x5.51”x4.33”) 

Weight 1.3 lbs. ( 600 grams)

*  laic fieneb eb nac sihT .regral egami eht ekam yllaic fiitra ot egami na ot slexip gnidda erawtfos ot srefer noitalopretnI  
when printing in larger formats.

2. SETUP
A. ASSEMBLE THE MICROSCOPE STAND

+ .xob eht morf stnenopmoc lla evomer ylluferaC  

+ .)11( tfahS troppuS eht otno )6( ralloC kcoL noitcennoC tfahS eht edilS  

+ .nethgit dna sdaerht esab ot )6( ralloC kcoL noitcennoC tfahS eht hcattA  

11.

6.
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B. ATTACH MICROSCOPE

+  redloH epocsorciM eht ni epocsorcim eht tresnI  
and tighten the Lock Nut (5) to secure it in place.

5.

C. INSTALL SOFTWARE—WINDOWS

+

The following interface will display automatically:

+

Wizard as it guides you through the installation

D. INSTALL SOFTWARE—MACINTOSH

+   gniwollof llatsni dna DC dedulcni eht no redlof CAM eht nepO 
on-screen prompts

+   llorcs dna unem erutpaC eht no kcilc ,oediv gnidrocer nigeb oT 
down to Video. Repeat to stop recording.

+  

NOTE : The software interface is the same as the PC version, but will look slightly di�erent.

Insert the DO Smart Analysis PRO CD into CD-ROM drive

Click ”Install” button and follow the Setup

Plug in the DO Smart PRO 5MP Microscope and open the
Delta Optical Smart Analysis PRO software. Your Microscope 
is now ready to use.
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A. CONNECTING

+  BSU eht aiv retupmoc ruoy ot epocsorcim eht tcennoC  
2.0 cable.

+  
to launch the software. 

+  nigeb dna tcennoc yllacitamotua dluohs epocsorcim ruoY  
streaming images.

NOTE:   If the microscope is not connected to the USB port, the following error message 
will be displayed: “No device detected. Please connect your microscope directly 
to an open USB port.”

B. FOCUSING

+ Now, rotate the Focus Wheel (3) to set the fi ne focus.

3. USING YOUR MICROSCOPE

1.1.

3.

4.
4.

2.
2.

+ .sucof esraoc eht tes ot )2( leehW tnemtsujdA thgieH eht nruT  + :dnats dedulcni eht gnisu egami na no sucof oT  

+ .epocsorcim eht gnidloh egairrac eht fo thgieh eht tsujdA  

+  ot )4( tuN kcoL tnemtsujdA thgieH egairraC eht nethgiT  
hold in place.

+  leehW kcoL eht nethgit ,noitisop eht htiw de fisitas ecnO  
(1), securing the carriage in place.

Click on the Smart Analysis Pro desktop icon

 ENGLISH   7

4. USING THE SOFTWARE

+  The Shutter Trigger (7) and the Illuminator Adjustment 
Wheel (8) are located on the cord.

+  When using the microscope in handheld mode, adjust 
the coarse focus by changing the distance between the 
microscope and your subject. Adjust fine focus with the 
Focus Wheel (3). 

A. CAPTURE A PHOTO/VIDEO

+  To capture a photo, click on the Capture menu and scroll down to Photo.

+   To begin recording video, click on the Capture menu and scroll down to Video. Repeat to stop recording.

8.

7.

3.

FILE:   U nder the File menu item, you will find:

 1.  Photos Directory:   Directs you to designate a folder on your hard drive for photo storage.

 2.  Videos Directory:   Directs you to designate a folder on your hard drive for video storage.

 3.  Exit:  Closes the Delta Optical Smart Analysis PRO software. 

B. OTHER MENU FILES
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- 1280 x 1024 (1.3 MP)

- 1920 X 1080 (2 MP)

- 2048 X 1536 (3 MP)

- 2320 X 1744 (4 MP)

- 2592 X 1944 (5 MP)
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OPTIO NS:  Under the Options menu item, you will find: 

 1.  Resolution: Sets the sensor image resolution.  
Choose from 4 resolution settings:

  - 1280 x 960 (1.3 MP)

  - 1600 x 1200 (2 MP)

  - 2048 x 1536 (3 MP)

  - 2592 x 1944 (5 MP)

 2. Date/Time: Turns the Date and Time stamp on or o�.

 3.  Language:  Changes the language setting. Choose from 12 languages:

  -  English, German, French, Spanish, Russian,  
Italian, Portuguese, Dutch, Polish, Japanese, Korean and Chinese

 4.  X,Y Guide:  Turns the reticle guide on the preview screen on or o�.

 5.  Full Screen Mode:  Enters full screen mode. Press  
ESC to exit.

ICO NS :   Along with the menu items, there are icons which mean the following:

 A.  Take Snap Shot

 B.  Start Video. Stop Video

 C .  Set Time Lapse Intervals

 D.  Full Screen Mode (press ESC to go back to main screen)
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+  The Delta Optical Smart Analysis PRO software includes a 
measurement feature. To use this feature, you must first 
perform a measurement calibration.

+  Make sure the X,Y Guide is set to “On” by selecting it in  
the Options Menu.

+  Double click the saved image to open it in the Image 
Preview screen.

+  Take a still image. The image will be displayed in the 
column on the right side of the screen.

+ Click on the Calibration icon 

+  Click and drag a line across a “known value” on the ruler image. 
Try to keep the line as perpendicular to the lines on the ruler as 
possible.

+  The “Adjust magnification” window will pop up as shown here.

+  In the box “Actual Dimension”, enter the “known value” from the 
calibration ruler

+  Set the height of the microscope and focus on your 
specimen. Then, replace your specimen with the 
calibration ruler.

+  Re-adjust the focus and align the calibration ruler so that 
the lines on the ruler are parallel with the vertical line on 
the X,Y Guide.

C. CALIBRATION AND MEASURE MENU
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+  egamI eht ot kcab og ,lufsseccus saw noitarbilac taht erusne oT 
Capture screen.

+  noci relur eht kcilC   and from the dropdown menu 
select the option “Any Angle Line”

+ .erofeb sa ”eulav nwonk“ emas eht ssorca enil a gard dna kcilC  

+  derusaem uoy ecnatsid eht ,lufsseccus saw noitarbilac eht fI 
should be exact to the “known value”

+  ,noitac fiingam ro thgieh eht gnignahc tuohtiw segami erutpac oT 
click on the Calibration icon. In the dropdown menu, select “Set 
Magnifi cation,” then “Set Capture Magnifi cation.”  

+  ni nwohs noitac fiingam eht ni epyT .raeppa lliw wodniw pu-pop A 
the upper right corner of the main window.

D. MEASURING TOOLS

You will notice in the measuring drop down menu there are many 
tools.  Here is the list of measurements you can take:

 MAIN

 1.  Any Angle:  Measures from point A to point B in a 
straight line.

 2.  Continuous Line:  Measures the total distance 
between multiple points. Start by measuring a straight 
line from point A to point B. Then, click and drag to 
continue measuring from point B to point C. (Can be 
repeated as many times as you like.)

 3.  Radius Circle:  Measures a circle’s radius.  Starting at 
the center, drag the cursor out to any edge.

 4.  Diameter Circle:  Measures a circle’s diameter.  
Starting at one outside edge, drag the cursor across to 
the opposite edge.

 5.  Three Point Angle:  Measures an angle between two 
points, starting from a radius point or an intersection 
point. Click on point A, (radius point) drag and click on 
point B, then click on point C.  The angle will be drawn 
and the angle degree will be displayed.

 SETTINGS

 1.  Line Properties: Changes the settings for line type, 
width, size and color.

 2.  Text Properties: Changes the settings for font type, 
size, style and color.

 3.  Set Units: Changes the units setting. Choose from 
millimeters, centimeters, pixels or inches.
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Delta Optical Smart Analysis PRO software includes functionality to mark, draw on, or and add notes to saved images. 
This can be handy for quick note taking and pointing out features on your specimen image.

1. MARKING

 +  To use this feature, click the Draw icon    in the Image Preview window.

 +  The complete choices in the Draw dropdown menu are:

MAIN

 1. Line:  Draws a straight line on the image.

 2. Arrow:  Draws a line with an arrow on the image.

 3.  Freehand:  Allows user to draw freehand. Good for quick, handwritten notes. 

 4.  Rectangle:  Draws a box. Good for calling out features on the image or framing text.

 SETTINGS

 1. Line Properties: Allows for setting the line type, size and color

2. ADD TEXT

 +  To type notes on the image, select the Type icon 

 +  In the dropdown menu, you can choose the font type, size and color.

E. TAKING NOTES AND MARKING THE IMAGE
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A. Save: Save your file

B. Copy to clipboard: Copy to open in other program

C. Copy: Save as a copy

D.  Previous: Takes you back to the previous image  
in save folder 

E .  Next: Takes you forward to the next image in  
save folder 

F. Undo: Takes you back one step

G. Redo: Takes you forward one step

H. Draw

I. Text/Notes

J. Measure

K. Calibration

L. Current Magnification (based on the latest calibration)

5. CARE  AND MAINTENANCE 
Your Delta Optical Smart PRO 5MP Microscope is a precision optical instrument and should be treated with care at 
all times. Follow these suggestions and your microscope will need very little maintenance throughout its lifetime.

+ Store your microscope in a clean, dry place.

+  Never use your microscope where operation of such 
devices is restricted.  Improper use creates the risk of 
serious accident.

+  Only use your microscope within the 23° to 120°F 
(-5° to 50° C) temperature range. Try to limit sudden 
temperature changes as this may create moisture in 
the microscope housing.

+  Do not try to access the internal components of your 
microscope or attempt to modify it in any way. Only 
authorized technicians should perform maintenance or 
repairs.

+  Keep your microscope away from water and other 
liquids. Never use it in rain or snow. Moisture creates 
the danger of fire and electric shock.

+  If the exterior of your microscope needs cleaning, wipe 
it with a moist cloth.

6. WARRANTY
Your Delta Optical Smart PRO 5MP Microscope has a two year limited warranty. Please visit the Delta Optical website for
detailed information on all Delta Optical microscopes:

www.deltaoptical.pl/blizej_zycia 

A .

B.

C.

D.

E .

F.

G.
H.

I.

J.

K.
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F. IMAGE PREVIEW ICONS EXPLAINED  




